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Content of this Instruction Manual
PSE is used for Picture Style Editor.
 indicates the selection procedure of the menu.

(Example: [Picture Style Editor] menu  [Quit 
Picture Style Editor].)
Square brackets are used to indicate items such 
as menu names, button names and window 
names that appear on the computer screen.
Text inside < > indicates a key on the keyboard.
** indicates a reference page.
Click to move to the relevant page.

 : Marks information that should be read 
before use.

 : Marks additional information you may find 
helpful.

© CANON INC. 2011     CT1-7195PSEME-000

Switching Between Pages
Click on arrows on the bottom right of the screen.

 : next page
 : previous page
 : return to a page you had previously 

displayed
Click on the headings on the right side of the 
screen to switch to the contents page of that 
heading. Also, click the item you want to read 
about on the table of contents to move to the 
relevant page.
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CANON SOFTWARE LICENSE AGREEMENT
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM 
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF 
THIS AGREEMENT.
This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]). 
IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT 
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX 
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM 
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.
In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions 
of this Agreement.
1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single 

computer. You may physically transfer the SOFTWARE from one computer to another provided 
that the SOFTWARE is used on only one computer at a time. You shall not install or use the 
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware 
configuration where the SOFTWARE is accessible to more than one CPU or to more than one 
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE, 
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, 
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART, 
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.
2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or 

copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer 
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation 
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for 
use of the SOFTWARE. No updates, fixes or support will be made available for the 
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, 
maintain and match the hardware and software components of your computer system. Thus 
Canon does not guarantee uninterrupted service or correction of errors or that the functions or 
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED 
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the 
SOFTWARE is warranted only against defective material under normal use for a period of ninety 
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt. 
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge 
when returned by you at your expense to your point of purchase and proven to be defective 
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original 
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if 
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE 
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S 
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS 
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, 
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF 
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE 
SOFTWARE OR THE USE THEREOF.
NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS 
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT 
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF 
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.
5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until 

expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may 
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate 
without notice to you if you fail to comply with any of the terms of this Agreement and you must 
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with 
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either 
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at 
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software 
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be 
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void 
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this 
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in 
the United States of America shall be governed and construed in all respects in accordance with 
the laws and regulations of the State of New York, without reference to choice of law principles. 
The terms of this Agreement as it relates to purchases of the Software in Canada shall be 
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the 
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of 
the SOFTWARE is subject to the United States, Canada and other applicable copyright and 
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its 
affiliated corporations and third party licensors under such laws.
Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any 
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU 
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS 
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE 
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON 
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS 
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS 
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO 
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY 
AUTHORIZED OFFICER OF CANON.

READ CAREFULLY BEFORE USING!
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Introduction
Picture Style Editor (hereinafter, “PSE”) is software that allows you to edit 
Picture Style to your unique image characteristics and save the edited 
results as original Picture Style files.

What is a Picture Style file?
A Picture Style file (extension “.PF2”) is an extended function of a 
Picture Style. It differs from the 6 preset Picture Styles (Standard, 
Portrait, Landscape, Neutral, Faithful and Monochrome) and 
provides image characteristics that are effective in a very limited 
number of scenes.
You can further expand your photographic expression by using a 
Picture Style file effective for a specific scene.

Main Features of PSE
With PSE, you can use the functions below to edit Picture Style to 
your unique image characteristics and save the edited results as 
original Picture Style files (extension “.PF2”).

Select a Picture Style to be used as a basis for your images
Set the [Sharpness], [Contrast], [Color saturation] and [Color tone]
Make minute adjustments to a specific color
Adjust the brightness and contrast (gamma characteristic)

In addition, you can register your saved original Picture Style files on 
a camera with the Picture Style function and then apply those styles 
to shot images. You can also use Digital Photo Professional to apply 
the styles to RAW images.

Color management
Use PSE in a computer environment with color management. 
Also, set the profile of the monitor you are using and the color space 
of the sample image to be used to perform the adjustments, etc. in 
the preferences window (p.16).

System Requirements

This software program is not compatible with UFS (UNIX File System) 
formatted disks.

Sample Images for Adjustment
PSE enables you to use RAW images shot with EOS DIGITAL cameras* 
(excluding the EOS DCS1 and EOS DCS3) as sample images for 
adjustment. You can then save the completed adjustments as original 
Picture Style files.
* Compatible with RAW images shot with EOS D6000 or EOS D2000 

that have been converted to RAW images using the CR2 Converter 
and have the “.CR2” extension.
For information on CR2 Converter, refer to Canon’s web site.

OS Mac OS X 10.5 to 10.6
Computer Macintosh with one of the above OS installed
CPU Intel processor 
RAM Minimum 1GB

Display Resolution: 1024 × 768 or more
Colors: Thousands or more
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Preparing Sample Images
PSE uses a sample image to perform the various adjustments and save 
the adjusted results as an original Picture Style file. For this reason, a 
sample image (p.2) to be used for this purpose needs to be prepared in 
advance and saved on your computer.
The settings performed in PSE are saved as a Picture Style file (p.15) 
which is separate from the sample image, and the sample image used 
to perform the adjustments itself is not affected at all.

Starting up PSE
Click the [Picture Style Editor] icon in the Dock.

The main window (Description on the right) appears when PSE 
starts up.

You can also start up PSE from the camera software “EOS Utility”. 
Refer to the “Function for Use with the Accessories” of “Reference” 
in “EOS Utility Instruction Manual” (PDF electronic manual) for 
details.

Opening a Sample Image
Open a sample image and perform various adjustments with that image 
as a basis.

Drag and drop a sample image to the main window.

The sample image is displayed in the main window with the 
camera settings at the time of shooting.
The [Tool palette] appears.

Drag and drop

If you adjust a RAW image in Digital Photo Professional 
(hereinafter, “DPP”) and then open it as a sample image with 
PSE, the adjustments made in DPP will not appear in the image.
If you open a RAW image, which has had the Auto Lighting 
Optimizer settings set in the camera or DPP, as a sample image 
with PSE, the Auto Lighting Optimizer settings set in the camera 
or DPP will not appear in the image.
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Basic Windows

You can select the display magnification and the display method, etc. of the sample image.

Main Window

Full view

Normal screen

Before and after 
adjustment 
comparison display
(Top/bottom split) 
(p.6)

Image rotation
(90 degree units to 
the left or right)

Before and after 
adjustment 
comparison display
(Left/right split) (p.6)

Display magnification 
(5 ratios: 12.5%, 25%, 
50%, 100% and 200%)

100% (actual pixel size) 
view

Color values of the cursor position (Before adjustment/after adjustment/
difference between before and after adjustment) (8-bit conversion)

Work color space display (p.16)

Cursor coordinates 
position

Color display mode (p.8, p.14)
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Enlarging a Specific Area
You can enlarge a specific area in the main window to 100%.

In the main window, double-click the area you want 
to enlarge.

The area you double-clicked is enlarged to 100% (actual pixel 
size). If you wait for a while, it changes to a clearer display.
To change the display position, drag on the image or drag the 
enlargement display position (p.7) in the [Navigator] window.
Double-click again to revert to the full view.

Double-click

Adjusting While Comparing with the Original Image
You can display before and after versions of an adjusted image in the 
same window and perform adjustments while checking the adjustment 
results.

Select [ ] or [ ].

The image is displayed split top and bottom or left and right.

[ ] (Top/bottom split) display [ ] (Left/right split) display

The image is displayed 
before adjustment at the top, 
and after adjustment at the 
bottom.

The image is displayed 
before adjustment on the left, 
and after adjustment on the 
right.
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In the main window, the display position of an image when it is enlarged 
and the image histogram are displayed. You can also set warning 
indicators to prevent excessive settings being made.

Displaying the [Navigator] window.
Select the [View] menu  [Navigator].

Navigator Window

Enlargement display position 
(p.6)
Move the display position by 
dragging

Histogram

Warning range

Warning indicator setting

Switches the histogram display

[Y] in the histogram display indicates luminance.

Setting the Warning Indicators
You can set warning indicators for luminance values (Y) and color 
values (RGB) which are useful for preventing excessive settings being 
made. Luminance and color value domains which are outside the set 
range blink as warning indicators on images in the main window.

1 Checkmark [Show warning on images] and select [Y] 
or [RGB].

2 Enter the upper and lower limit values of the warning 
range.

The domain where values are outside the upper and lower limit of 
the range blinks on the image in the main window.
To stop the warning indicators, remove the check mark from the 
[Show warning on images] checkbox.CO
PY
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You can adjust the image characteristics of the Picture Style file by using 
the various functions of the [Tool palette].
Because the adjustments made with the [Tool palette] are immediately 
applied to the image in the main window, you can check the results as 
you work.

Tool Palette

Select a Picture Style to be used as a basis (p.9)
Sharpness, Contrast, Color saturation, 
Color tone settings (p.10)

Minute adjustments to 
a specified color (p.11)

Save a Picture Style file (p.15)

Load a Picture Style file (p.10)

Adjust the brightness and contrast (gamma characteristic) (p.14)

Adjustment color list (p.13)

Color display mode (p.14)

You can select the [View] menu  [Tool palette] to alternate the [Tool 
palette] show/hide.

Pre-adjusting the Images
Sample images used in the adjustment process (p.2) which do not have 
proper exposure or white balance can be adjusted using the 
[Preliminary adjustment] window to correct their brightness and white 
balance.
However, please remember that adjustments made with the [Preliminary 
adjustment] window are merely pre-adjustments for correcting 
adjustments made with the [Tool palette] (Description on the left). For 
this reason, adjustments made with the [Preliminary adjustment] window 
are not saved in the Picture Style file which you create.
If the sample image used for making the adjustments has proper 
exposure and white balance, you do not have to make adjustments with 
the [Preliminary adjustment] window.

1 Select the [Tools] menu  [Preliminary adjustment].
The [Preliminary adjustment] window appears.
When the [Preliminary adjustment] window appears, the display 
switches to normal display, even if the main window display is 
showing a comparison of an image before and after adjustment 
(p.6).

2 Adjust to correct the brightness of the image.

The adjustments are applied to the image.

Correcting the Brightness

Drag to the left or right 
to adjust
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Adjust to correct the white balance.

The adjustments are applied to the image.

Correcting the White Balance

Select the white balance

The color temperature slider
Select [Color temperature] from the white balance list 
box, and then drag the slider left or right

Click white balance
Click the [ ] 
button and then click on 
a point that is to be the 
standard for white

Setting the Image Characteristics
You can adjust the image characteristics by using the various functions 
of the [Tool palette].
All the adjustments made with the functions in the [Tool palette] become 
the image characteristics of the Picture Style file.

Select the Picture Style to become the basis of the adjustments from the 
5 preset (except Monochrome) Picture Styles (Standard, Portrait, 
Landscape, Neutral and Faithful).
You can also register and use a Picture Style file effective for the scene 
that you have downloaded from Canon’s web site.

Select a Picture Style.

The selected Picture Style is applied to the image.

Selecting a Picture Style to Be Used as a Basis
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Using a Downloaded Picture Style File 
Effective for the Scene

1 Click the [ ] button.
The [Open Picture Style file] window appears.

2 Select a Picture Style file to be registered and click 
the [Open] button.

The selected Picture Style file is applied to the image.

Original Picture Style files created with PSE (p.15) can also be 
registered and used by following the procedure above.
Picture Style files compatible with PSE are files with the “.PF2” 
extension.

1 Click the [Advanced] button.

The [Advanced Picture Style settings] window appears.

2 Drag each slider and then click the [OK] button.

The settings are applied to the image.

Setting Sharpness, Contrast, Color Saturation and Color Tone

Drag the sliders left or 
right
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You can make minute adjustments to a color you have specified, using 
the hue, saturation and luminosity functions in order to get the color you 
want. You can also set a range for the effect on surrounding colors 
which occurs when you adjust the colors you have specified.

1 Specify the color you want to adjust.
Click the [ ] button and then click the color you want to 
adjust on the image.

The selected color is displayed as an adjustment point and as 
[ ] on the color wheel.

Making Minute Adjustments to Color

Click

Click

2 Determine the range of effect for the color you want 
to adjust.

The range of effect for hue, saturation and luminosity can be set 
within the limits below.

Color of the adjustment point selected in step 1

Range of upper and lower limit of saturation 
Drag to move towards the center or towards 
the outer perimeter

Range of upper and lower limit of hue
Drag to move towards the perimeter of the circle

Range of 
upper and 
lower limit of 
luminosity
Drag to 
move up or 
down

Luminosity level of the adjustment 
point selected in step 1

Within the frame is the range of effect

Setting Range

Hue 30 - 180 degrees

Saturation 30 - 100

Luminosity 30 - 100
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3 Adjust the color.

The color is adjusted to the range specified in step 2 and the 
color of the image changes.
When dragging the slider, the point before adjustment [ ] and 
the point after adjustment [ ] will be displayed on the color 
wheel. 

Drag to the left or right to adjust

4 Check the range of application.
If you checkmark [Show affected area on images], the range of 
application of the adjusted color blinks on the image.

5 Repeat steps 1 to 4 to adjust multiple colors.
You can select and adjust colors for up to a maximum of 100 
spots.

You can also specify the color to be adjusted in the different method 
from the one explained in step 1 (p.13).
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In addition to specifying the adjustment point by clicking the color on the 
image (p.11), you can also specify the color directly on the color wheel 
or by entering the color value.

Specifying the Color on the Color Wheel  

Specifying the Color by Entering the Color 
Value

1 Click the [ ] button (p.11).

2 Click the color you want to adjust on the color wheel.
The selected color is displayed as an adjustment point [ ] on 
the color wheel.

1 Select the [Edit] menu  [Specify the numerical 
values for color adjustment].

The [Specify the numerical values for color adjustment] window 
appears.

2 Enter the color value.
The entered color value is displayed on the color wheel as an 
adjustment point [ ] on the color wheel.

Specifying the Color Directly
In addition to displaying colors before and after adjustment, the 
adjustment color list (p.8) shows any overlapping of the range of effect 
of adjusted colors, and has a checkbox for applying adjusted colors and 
preventing adjusted colors from being applied.

Overlapping with the Range of Effect of 
Adjusted Colors
When you select an adjusted color from the list and [ ] appears, the 
range of effect (p.11) of the adjusted color is overlapping with the range 
of effect of other adjusted colors. Moreover, the overlapping areas will 
be displayed in gray on the color wheel and the color is applied by 
aggregating adjustment results.
To avoid an overlapping of the ranges of effect, select the subject color 
which has a [ ] and reset it so that the range of effect of the hue and 
saturation no longer overlap.

Deleting an Adjusted Color
Be aware that you cannot recover deleted colors.

From the list, select the adjusted color you want to 
delete and then press the <delete> key on the 
keyboard.

The selected adjusted color is deleted.

Displaying the Adjustment Color List and its Functions

Color after adjustment

Color before adjustment

Displays any overlapping in the range of effect of adjusted colors
Remove the checkmark to prevent the adjusted colors from being applied
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You can select the color display mode which will be the basis for color 
adjustment from three options (HSL, Lab or RGB) as well as check 
values for adjusted colors.

When “HSL” is selected for the color display mode, you can only 
change the color value for before adjustment by entering a 
number.

Color Display Mode

Switches the color display mode

Color value before adjustment
Color value after adjustment

HSL is a color mode expressed by the three elements of hue (H), 
saturation (S) and luminosity (L).
Lab is a color mode developed by the CIE (Commission 
Internationale d’Eclairage) where L displays lightness, a displays 
color elements from green to magenta and b displays color 
elements from blue to yellow.
RGB is a color mode which expresses red (R), green (G) and 
blue (B), the three primary colors (additive colors) of the visible 
light spectrum.

You can adjust the brightness and contrast of a specific area using the 
tone curve.

Adjust the brightness and contrast.

The brightness and contrast of the image change.
The horizontal axis shows the input level and the vertical axis 
shows the output level.
The maximum number of [ ] is 10.
To delete a [ ], select the [ ] and then either press the 
<delete> key on the keyboard or double-click on the [ ].

Adjusting Brightness and Contrast (Gamma Characteristic)

Click to add a [ ] 
(adjustment point) and 
adjust by dragging

The setting value of the 
selected point (you can 
also enter numerical 
values)
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Saving the Adjustments as a Picture Style File
Adjustments specified in the [Tool palette] (p.9 to p.14) are saved on 
your computer as an original Picture Style file (extension “.PF2”).
The adjustments are saved as a Picture Style file which is separate from 
the sample image, and the sample image used to perform the 
adjustments itself is not affected at all.

1 Click the [ ] button.
The [Save Picture Style file] window appears.

2 Specify the name and destination and then click the 
[Save] button.

If you do not want to show the settings adjusted in PSE, 
checkmark [Disable subsequent editing] and save, so that the file 
cannot be opened again in PSE.

The file is saved as a Picture Style file in the specified save 
destination. 

Even if you checkmark [Disable subsequent editing] and save, you 
can use the Picture Style file the same way as the Picture Style file 
without chekmarking and saved (Description on the right). However,  
you will no longer be able to open the Picture Style file in PSE. For 
this reason, we recommend that you save separately beforehand 
the Picture Style file without checkmarking [Disable subsequent 
editing].

Using a Picture Style File
Saved Picture Style files can be registered in the camera and applied to 
shot images. They can also be applied to RAW images using Digital 
Photo Professional (hereinafter, “DPP”).

Picture Style files saved on your computer can be registered to the 
“Camera that has a Picture Style function settings” (For information on 
whether your camera is equipped with the Picture Style function, refer to 
the camera’s Instruction Manual.) using EOS Utility and applied to shot 
images. 
Refer to “Applying Picture Style Files to the Camera” of “Chapter 2 
Setting the Camera from Your Computer” in “EOS Utility Instruction 
Manual” (PDF electronic manual) for details on operation.

Picture Style files saved on your computer can be applied to RAW 
images using DPP. 
Refer to “Using a Picture Style File” of “Chapter 3 Advanced Image 
Editing and Printing” in “Digital Photo Professional Instruction Manual” 
(PDF electronic manual) for details on operation.

Registering a Picture Style File to the Camera

Using a Picture Style File with DPP
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Preferences
You can perform color management settings such as specifying the 
work color space for the sample image displayed in the main window, or 
setting the profile for the monitor.

1 Select the [Picture Style Editor] menu  [Preferences].
The [Preferences] window appears.

2 Specify the required settings and then click the [OK] 
button.

The settings are applied.

If you have changed the work color space during the adjustment 
process, the adjustment point on the color wheel sometimes moves 
in conjunction with the selected work color space.

Quitting PSE
In the main window, select the [Picture Style Editor] 
menu  [Quit Picture Style Editor].

PSE quits.
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Reference

If PSE is not operating correctly, refer to the items below.

You cannot install software unless you are logged into an account with 
Administrator privileges. Log in again into an account with 
Administrator privileges. For how to log in and how to specify 
Administrator settings, refer to the User’s Manual for the Macintosh 
computer you are using or for Mac OS X.

PSE does not operate correctly on a computer if its system 
requirements are not met. Use PSE on a computer with compatible 
system requirements (p.2).
Even if your computer has the RAM capacity (memory) described in 
the system requirements (p.2), if other applications are running at the 
same time as PSE, you may not have sufficient RAM (memory). Quit 
any applications other than PSE.
The software preferences file may be corrupted. Quit all applications 
and follow the procedure below to delete the preferences file from the 
[Preferences] folder before restarting PSE.
In the hard disk drive where the system is saved, open the [Users] 
folder  folder of the logged in user  [Library] folder  [Preferences] 
folder, and delete the [com.canon.PictureStyleEditor.plist] file.

Sample images that are not supported by PSE (p.2) do not display.

Installation could not be completed correctly

PSE does not work

Images do not display properly

Troubleshooting
Quit any applications before uninstalling the software.
To uninstall the software, log in with Administrator privileges.
To prevent computer malfunctions, always restart your computer after 
you have uninstalled the software. Re-installing the software without 
first restarting your computer is particularly likely to result in computer 
malfunctions.

1 Display the folder in which the software is saved.
Open the [Canon Utilities] folder.

2 Drag the [Picture Style Editor] folder to the Trash.

3 Select the [Finder] menu on the desktop  [Empty 
Trash].

The software is deleted.

4 Restart your computer.

Deleting the Software (Uninstalling)
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You cannot retrieve data that you have emptied into the Trash 
and deleted, so be particularly careful when deleting data.
You cannot install the software again if you have just moved the 
[Picture Style Editor] folder to the Trash. Be sure to select the 
[Finder] menu  [Empty Trash].

About This Instruction Manual
It is prohibited to reproduce, in whole or part, the contents of this 
Instruction Manual without permission.
Canon may change without notice the software specifications and 
contents of this Instruction Manual.
The software screens and displays printed in this Instruction Manual 
may differ slightly from the actual software.
The content of this Instruction Manual has been reviewed thoroughly. 
However, if you should notice any errors or omissions, please contact 
a Canon Service Center.
Please note that irrespective of the above-mentioned, Canon does 
not take responsibility for the outcome of the operation of the 
software.

Trademark Acknowledgments
Macintosh is a trademark of Apple Inc., registered in the United States 
and other countries.
Other names and products not mentioned above may be registered 
trademarks or trademarks of their respective companies.
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